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Introduction 

 

In this lab exercise, you learn the major features and functions of self-service 

provisioning of virtual servers and software using IBM® Tivoli® Service 

Automation Manager. This lab exercise takes you step-by-step through the 

various tasks. You, as a cloud administrator, request a project with a VMware 

virtual server using the self-service user interface and manage the virtual servers 

and resources through the lifecycle of the project. You also learn how to monitor 

the deployment status with the Tivoli Service Automation Manager 

administrative user interface (UI), and perform basic cloud administrator tasks, 

such as customizing the service catalog. 

 

Later in this lab exercise, you learn how to create and restore virtual server 

backups. You also learn how to install software as part of the virtual server 

deployment. You learn how to remove servers and cancel projects. You learn 

about customers and how to customize Tivoli Service Automation Manager for 

different customers. Finally, you disable automatic approval of requests and view 

the Tivoli Service Automation Manager reports. 

 

Three systems are provided for each lab session, as described in the following table. 

 

Host name IP Description 

vm100 192.168.80.100 
SUSE 10 SP2: Tivoli Service Automation Manager 

management server 

vm104 192.168.80.104 
Windows 2003 STD: VMware vCenter Server, Tivoli 

Service Automation Manager UIs 

vm105 192.168.80.105 VMware ESX Server 4.0 

 

 

You log in to the vm104 system, which is your primary user and administrator 

workstation. From here, you access the Tivoli Service Automation Manager user 

interfaces and other applications to perform all the exercises. 
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Refer to the following table for various user names and passwords that are used in the 

exercises. 

 

 

 

User Name Password Component Description 

Administrator object00 OS(vm104) Administrator user 

 

maxadmin 

 

object00 

Tivoli Service 

Automation Manager 

Tivoli Service Automation Manager 

and Tivoli’s process automation 

engine administrator 

cloudadmin object00 cloud administrator Self-service UI 

tived1dmin object00 
team administrator for 

TIVED1 customer 
Self-service UI 

 

 

 

 

 

1.  As shown in this slide, John begins by using the self-service UI to define his 

requirements, thus creating a service request. 
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2. Tivoli Service Automation Manager selects the appropriate resources, runs the 

appropriate management plan to install the image, and deploys the 

image through Tivoli Provisioning Manager. 

 

3.  John receives a notification that his request has been completed and the system is 

ready. 

 

4.  John provides the testers with the login information he was given in the email. 

 

5.  The testers perform the testing. 

 

6.  Later, more testers are added to complete the test. 

 

7.  John uses the self-service UI to request additional virtual servers for the new 

testers, thus creating another service request. John receives another 

notification when the request is completed. 

 

8.  John provides the login information to the new testers, and testing continues. 

 

9.  When the testing is complete, John saves a copy of the virtual server in the 

image catalog and returns the resources to the pool. 
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Fundamentals of Cloud Computing 

 

 

Exercise 1: Logging on to Tivoli Service 

Automation Manager UIs 
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You log in to the vm104 system to access the Tivoli Service Automation Manager 

UI environment and VMware. 

 

Note: Use different browsers for the administration and user interfaces to 

eliminate issues that arise with the browser caching the credentials. This 

action also helps distinguish between administrator and user functions. Use 

the following browsers: 

• Internet Explorer for Tivoli Service Automation Manager UI (admin) 

• Firefox for the self service UI (user) 

 

1.  Log in to vm104 virtual server as Administrator with password object00. 

2.  Log in to the Tivoli Service Automation Manager administrative UI. 

a.  Open an Internet Explorer window and browse to the following web address: 

https://vm100.tivoli.edu:9443/maximo 

This web address is the home page. 

b.  Log in with user ID maxadmin and password object00. 

The Tivoli Service Automation Manager administrative UI opens. 

 

c.  After you have logged in and verified connectivity to the application, log 

out and close the browser. 
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3.  Log on to the self-service UI as cloudadmin. This user is a Tivoli Service 

Automation Manager cloud level administrator that was created for 

these exercises after the installation completed. Use this ID initially 

to log on to the self-service user interface. 

a.  Open a Firefox window and browse to the following web address: 

https://vm100.tivoli.edu:9443/SimpleSRM/ 

This web address is located on the Bookmarks toolbar as self-service UI. 

b.  Log in with user ID cloudadmin and password object00. 

The self-service UI opens. 

 

 

c.  Expand the customer drop-down list. Three customers are defined. 

 

User cloudadmin can submit requests for each of the customers. 

PMRDPCUST is the default customer defined with Tivoli Service 

Automation Manager. TIVED1 and TIVED3 are customers created for 

the lab exercises. 
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During almost all lab exercises, you submit requests for the PMRDPCUST 

customer. 

 

d.  After you log in and verify connectivity to the application, log out 

and close the browser. 
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Fundamentals of Cloud Computing 

 

 

Exercise 2: Logging in to VMware vSphere 

client 
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Log in to the VMware vSphere client to verify that VMware is operational and that you have two 

Linux templates defined: 

1.  Double-click VMware vSphere Client on the vm104 desktop. 

 

2.  In the VMware vSphere Client login window, perform the following steps: 

a.  Specify localhost for the IP address / Name field. 

 

b.  Select Use Windows session credentials. 

 

c.   Click Login. 

 

3.  Select View > Inventory > VMs and Templates. 

The sles11_vs01 and sles11_vs02 templates are visible in the left 

pane. You use these templates to deploy new virtual servers from 

Tivoli Service Automation Manager. 

 

 

Note: If the templates appears as sles11_vs01 (disconnected) or sles11_vs02 

(disconnected), notify your facilitator. 

4.  Minimize the VMware vSphere Client window. 
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Fundamentals of Cloud Computing 

 

 

Exercise 3: Opening the email application 



FCC - Exercises – Guide for Students  Exercise 3 

© 2014 IBM Corporation Page 16 of 173 

 

 

As you perform tasks using the self-service UI, you receive email notifications. 

Your lab system is already set up to run Mozilla Thunderbird. 

1.  Locate the Mozilla Thunderbird icon on the desktop of vm104. Double-click 

the icon to open the application. 

A list of users is displayed in the left pane. 

 

 

 

 

 

As you proceed through the remaining exercises, notifications sent from 

the Tivoli Service Automation Manager workflows are added to the inbox 
of cloudadmin and testadmin. View them as they arrive to become 

familiar with them. 

 

2.  Minimize the Mozilla Thunderbird window. 
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Fundamentals of Cloud Computing 

 

 

Exercise 4: Submitting a new VMware 

deployment request using the quick path 
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After the cloud administrator configures the environment and sets up the 

applications, users can submit requests for virtual server provisioning. You use 

the self-service UI to request virtual server deployments. 

 

To perform these tasks, you must log in with a user ID that has a role of either 

Cloud Administrator or Team Administrator, by default. During the first series 

of these exercises, you use a cloud administrator for simplicity, but you can 

complete all of the tasks as a team administrator. 

 

Tivoli Service Automation Manager was redesigned so that users can quickly 

submit requests when the default values are sufficient for their needs. This use 

case is shown in this exercise. 

1.  Open a Firefox window and open the self-service UI. Use the Self-Service 

UI bookmark or browse to this location: 

https://vm100.tivoli.edu:9443/SimpleSRM/ 

 

2.  Log in to the self-service UI as cloudadmin with password object00. Verify 

that you are working for the PMRDPCUST customer. 

 

3.  Click Request a New Service > Virtual Server Management > Create Project with 

VMware Servers. 
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4.  Enter the following information in the Project Details window: 

– Project Name: <your_initials>01 

– Team to Grant Access: TEAM0 

– Start Date: [Use the default value] 

– End Date: [Use the default value] 

 

5.  Click Next. 

 

6.  Enter the following information in the Requested Image window: 

– Resource Group Used to Reserve Resources: VMware System x 

– Image to be Deployed: SLES11_image1 

– Number of Servers to be Provisioned: 1 

 

 

7.  Click Finish to accept the defaults for the remaining options. 
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8.  Verify that the Summary section is similar to the following screen capture. 

 

 

 

9.  Click Finish to submit your request. 

 

10. Verify that the request in the My Requests portlet listed first as New, 

Queued, and then In Progress. For example, Demo01 is in progress in 

the following example. 

 

 

Note: You monitor the status of the deployment request using the 

administrative interface in the next exercise. Wait until the status of your 
request shows In Progress before you start the next exercise. 
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Exercise 5: Monitoring the deployment status 
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The cloud administrator can log in to the Tivoli Service Automation Manager 

administrative UI and monitor several operational aspects of the service 

requests, projects, and the workflows that interface with the hypervisor 

managers and the virtual machines. In this exercise, you perform some of these 

monitoring functions. 

1.  If you are not already logged in, log in to the Tivoli Service 
Automation Manager administrative UI as maxadmin with 

password object00. 

2.  Click Go To > Service Automation > Service Deployment Instances. 

3.  Press Enter to list all instances. 

4.  Click <your_initials>01. 

 

Note: When you create a new project, the application creates a Service 

Deployment Instance, which you can view in the administrative interface. 

This instance tracks and manages the service landscape known as the 

service topology. The Service Deployment Instance is exposed to the user 
as a project in the My Projects portlet. Each request to modify this topology 

is tracked with a unique service request. These service requests are exposed 
to the user in the My Requests portlet. 

 

5.  Verify that the status is In Transition. This status means that the workflow 

is currently running to deploy the virtual system. 

 

6.  Click the Messages tab. You can view the messages from deployment; 

however, there typically are no messages here yet. 

7.  Click Start Center > Automation Package Developer tab > Provisioning Workflow 

Status. 
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Two workflows are still in progress. 

 

 

 

 

8.  Click the Refresh button to update the page. Continue to the next step while 

the workflow is in progress. You check the status of the workflow later. 

You see a status of Success when the workflow is completed. 

 

9.  Log in to the VMware vSphere client as Administrator with password 

object00. Monitor the status to verify that a new virtual server with a name of 

vm192168080129 is created. 

 

 

 

 

 

10. Return to the Tivoli Provisioning Manager Workflow Status page to see the progress. 

Click Refresh to update the page until the workflows complete. 

The workflow log contains approximately 700 entries when the workflow 
completes. This task might take 10 minutes or more, depending on 

system load. 

 

11. Return to the self-service UI. 
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12. Verify that the status of the <your_initials>01 deployment request is 

Resolved in the My Requests portlet, and that the new project is 

Operational in the My Projects portlet. 
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Fundamentals of Cloud Computing 

 

Exercise 6: Logging in to the virtual server 

(optional) 
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In the exercise, you log in to the virtual server that you provisioned using the 

vSphere client to demonstrate that the virtual server is operational. 

1.  Open the Mozilla Thunderbird application. Open the email with a subject 

Your request to start a new project has been processed in the 

cloudadmin inbox. The text describes the virtual server, similar to the 

following example: 

Dear Cloud Administrator, 

 

you have started a new project Dem01 with the following topology: 

 

The server vm192168080129 has been added with the following 

parameters: 

Server host name: 

vm192168080129 Number of 

CPU(s): 1 

Number of tenths of physical 

CPUs: 2 Amount of Memory: 

512 MB 

Swap Size: 0 GB 

IPv4 address(es): 

192.168.80.129 IPv6 

address(es): 

Disk Space Size: 

2 GB Admin 

Password: 

<password> 

 

 

2.   Write the Admin password here: . 

Passwords are case- sensitive. 

 

3.  Log in to vm192168080129. You can use either the VMware vSphere Client 

or PuTTY to access the virtual server. The instructions for the VMware vSphere 

Client follow. 

a.  Log in to the VMware vSphere Client as Administrator with password object00. 

 b.  Right-click vm192168080129. 

c.  Click Open Console. 

 

4.  Log in as user root with the Admin password that you wrote down. 
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5.  Enter the command cat /etc/SuSE-release to verify that your virtual 

machine is running SUSE Linux Version 11. 

vm192168080129:~ # cat /etc/SuSE-

release SUSE Linux Enterprise 

Server 11 (i586) VERSION = 11 

PATCHLEVEL = 0 

 

6.  Enter the command exit to log off. 
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Fundamentals of Cloud Computing 

 

 

Exercise 7: Modifying the virtual server by 

adding additional memory 
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In preparation for installing and running software, you increase the amount of 

memory on the virtual machine that you provisioned in the previous exercise. 

  1.  If you are not already logged in, log in to the self-service UI as 
cloudadmin with password object00. Verify that you are 

working for the PMRDPCUST customer. 

 

  2.  Click Request a New Service > Virtual Server Management > Modify 

Server > Modify Server Resources. 

 

 

 

 

 

  3.  Enter the following information: 

– Select Project Name: <your_initials>01 

– Select Server Name: vm192168080129 

– CPU: [do not change] 

– Memory: [enter 1 in the GB field] 

– Disk: [do not change] 

The memory now shows 512+512 to indicate that the virtual 

machine currently has 512 MB of memory and that an additional 

512 MB of memory will be added. 

 

 

 

 

 

  4.  Click OK to submit the request. 
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The request in the My Requests portlet is listed first as New, Queued, 

and In Progress. Wait for the request to be Resolved. 

 

 

 

Note: You can watch the activity in the Recent Tasks portlet in the vSphere 

client. You see the virtual machine being powered off, reconfigured, and then 

powered on. 

 

  5.  When the request completes, you can click manage servers in the My 

Projects portlet to view the details for vm192168080129. The memory 

is now 1 GB. 
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Exercise 8: Adding a VMware server with a 

monitoring agent to an existing project 
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  1.  If you are not already logged in, log in to the self-service UI as 

cloudadmin with password object00. Verify that you are 

working for the PMRDPCUST customer. 

 

  2.  Click Request a New Service > Virtual Server Management > Modify Project > Add 

VMware Servers. 

 

 

 

  3.  Enter the following information in the Project 

Details window: Project Name: 

<your_initials>01 

 

 

  4.  Click Next. 
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  5.  Enter the following information in the Requested Image window: 

– Resource Group Used to Reserve Resources: VMware System x 

– Image to be Deployed: SLES11_image1 

– Number of Servers to be Provisioned: 1 

 

 

 

 

 

  6.  Click Next. This time, you specify additional details about the server being 

requested. 

 

  7.  Enter the following information in the Server Details window: 

– Virtual CPU: 1 

– Physical CPU: 0.3 

– Main Memory: 1.0 GB 

– Swap: 0 GB 

– Disk: 3 GB 
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  8.  Click Next. 

  9.  In the Additional Software window, do not make an entry in the 
Select Software to Install field at this time. 

  10. Click Next. 

  1.  Make sure that the Network Configuration window lists only 

one network, the Management Segment. 

There is only one network, the Management Segment. 

 

  2.  Click Next. 

 

  3.  Enter the following information in the Other 

Settings window: Monitoring Agent to be 

Installed. [selected] 

 

  d.   Click Next. 
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The Summary section is similar to the following screen capture. 

 

 

 

 

  e.  Click Finish to submit your request. 

 

  4.  This task might take 15 minutes or more, depending on system load. 

While the task is processing, you can continue with the next exercise. 
This task completes when the status of the <your_initials>01 

deployment request is Resolved in the My Requests portlet. 
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Fundamentals of Cloud Computing 

 

 

 

Exercise 9: Customizing the service catalog 
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The cloud administrator has already made some service catalog 

customizations to hide the non- VMware services for creating new projects. 

However, the non-VMware service offerings for adding servers to existing 

projects are still visible in the catalog. In this exercise, you hide those service 

offerings because the only cloud pools available in this environment are 

VMware. 

  1.  If you are not already logged in, log in to the self-service UI as 
cloudadmin with password object00. Verify that you are 

working for the PMRDPCUST customer. 

 

  2.  Click Request a New Service > Virtual Server Management > Modify Project. 

Service offerings are available to add servers with non-VMware 

hypervisors. These service offerings are not configured in this test 

environment, which is VMware only. 

 

 

 

 

 

  3.  Log out and close the browser. 

 

  4.  If you not already logged in, log in to the Tivoli Service 
Automation Manager administrative UI as maxadmin, with 

password object00. 

 

  5.  Click Go To > Service Request Manager Catalog > Offerings. 
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  6.  Filter the offerings based on an offering name of PMRDP and the description of 

Add. 

Eight offerings meet these criteria. 

 

 

 

 

  7.  Check the Select Records box below the list of offerings. 

 

  8.  Select all of the non-VMware offerings that are active. These offerings are 

items 2, 3, 4, 5, 7, and 8 in the list. 

 

  9.  Choose Change Status from the Select Action drop-down list. 

 

  10. Set the New Status to Pending and click OK. 

 

 

 

Note: The method you use here for hiding the non-VMware service offerings 

is a simple way to remove offerings from all catalogs and all user groups. 

Another method is to add and remove specific service offerings from the 

catalogs that are associated with each role-based user group. The cloud 

administrator can then decide which service offerings to make available to 

which users based in their role. 
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  11. Service catalogs are dynamically loaded by the self-service UI. 

Therefore, log out of any remaining self-service UI instances. Users 

receive the updated service catalog at the next login. 

 

  12. Log in to the self-service UI as cloudadmin with password object00. 

Verify that you are working for the PMRDPCUST customer. 

 

  13. Click Request a New Service > Virtual Server Management > Modify 

Project. 
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Notice that the service offerings with non-VMware hypervisors have been 

removed. 
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Fundamentals of Cloud Computing 

 

Exercise 10: Creating a future reservation 

request 
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In this exercise, you create a future reservation for a new project with a single 

VMware virtual machine. The virtual machine is not provisioned now, but the 

resources are reserved so that the provisioning task can allocate them on the 

designated date. 

  1. If you are not already logged in, log in to the Tivoli Service Automation 
Manager self- service UI as cloudadmin with password object00. 

Verify that you are working for the PMRDPCUST customer. 

 

  2.  Click Request a New Service > Virtual Server Management > Create 

Project with VMware Servers. 

 

 

 

 

 

  3.  Enter the following information on the Project Details window: 

– Project Name: <your_initials>02 

– Team to Grant Access: TEAM0 

– Start Date: [select one week from today] 

– End Date: [select three weeks from today] 

 

Tip: Change the end date before the start date because a project cannot end before it 

begins. 
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  4.  Click Next. 
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  5.  Enter the following information on the Requested Image window: 

– Resource Group Used to Reserve Resources: VMware System x 

– Image to be Deployed: SLES11_image1 

– Number of Servers to be Provisioned: 1 

 

 

 

 

  6.  Click Finish to accept the defaults for the remaining options. 

 

  7.  Verify that the Summary section is similar to the following screen capture. 

 

 

 



FCC - Exercises – Guide for Students  Exercise 10 

© 2014 IBM Corporation Page 49 of 173 

  8.  Click Finish to submit your request. 

 

  9.  Verify that the request in the My Requests portlet listed first as New and 

then Queued. This request does not go to the In Progress status until 

the future date you specified. Your 
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project name is shown in the My Projects portlet with a Draft status. 

You also see an Upcoming Project with the same name and the 

future start date that you provided. 
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Fundamentals of Cloud Computing 

 

 

 

Exercise 11: Displaying projects and servers in 

the self-service UI 
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  1.  If you are not already logged in, log in to the self-service UI as 
cloudadmin with password object00. Verify that you are 

working for the PMRDPCUST customer. 

  2.  Verify that the state of the <your_initials>01 project in the My Projects portlet is 

Operational. 

  3.  Click <your_initials>01 project in the My Projects portlet to display 

the details for the project. 

You see two servers. The first server was provisioned without the 

monitoring agent, and the second was provisioned with the monitoring 

agent. Because of integration between Tivoli Service Automation 

Manager and IBM Tivoli Monitoring, monitoring data is displayed in the 

self-service UI, as shown in this diagram. 

 

 

  4.  Close the Project window. 

  5.  Click Manage Servers in the My Projects portlet. 

 

You see both servers here also, and you see monitoring data for the second 

server. Another entry is visible for the future reservation. 

  6.  Close the Manage Servers window. 
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Fundamentals of Cloud Computing 

 

 

Exercise 12: Monitoring a virtual server in the 

IBM Tivoli Monitoring Tivoli Enterprise Portal 

(optional) 
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In this exercise, you log in to the Tivoli Enterprise Portal to view IBM Tivoli 

Monitoring application data for the virtual server. 

  1.  In order to save resources in this demonstration environment, the Tivoli 

Enterprise Portal Server database is not started. Start the database on 

vm100. 

  a.  Start the PuTTY application from the VM104 desktop and 

double-click the saved session named vm100 - tsam. 

 

 

 

 

 

  b.   If you receive a PuTTY security alert, click Yes to trust this host. 

 

  c.  At the login prompt, enter the user name db2inst1 and object00 as the 

password. 

 

  d.  Enter the command db2start to start the database. 

db2inst1@vm100:~> db2start 

09/21/2011 13:27:02 0 0 SQL1063N DB2START processing 

was successful. SQL1063N DB2START processing was successful. 

 

  e.  Enter the command exit to close the PuTTY session. 
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  2.  Return to the Tivoli Service Automation Manager administrative UI (Internet 

Explorer) 

and press <CTRL>+T to open a new tab. 

  3.  Browse to http://vm100.tivoli.edu:1920///cnp/client. 

 

Note: 

  a.  If you are prompted to run certain restricted content, click the yellow banner, 

click 

Add-on Disabled, and click Run Add-on. Click Run. Click Continue. 

 

  b.  If you see message KFWITM474E, click Continue. 

  4. When the Tivoli Enterprise Portal logon page opens, enter sysadmin for 

the logon ID and leave the password field empty. Click OK. If you are 

prompted with a security alert, click OK. 

 

  5.  In the Navigator portlet on the left, click the plus icon (+) next to 

Linux Systems to expand the monitoring group. 

  6.  Click the plus icon (+) next to host name vm192168080130 to show the Linux OS 

agent. 
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  7.  Click Linux OS to see an overview of monitoring data for this virtual machine. 

 

 

 

  8.  Log out and close the browser window. 
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Fundamentals of Cloud Computing 

 

 

 

Exercise 13: Creating a backup image of the 

virtual machine 
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If you want to be able to restore a virtual machine to a specific time, you can take a 

backup image. 

  1.  If you are not already logged in, log in to the self-service UI as 

cloudadmin with password object00. Verify that you are 

working for the PMRDPCUST customer. 

 

  2.  Click Request a New Service > Virtual Server Management > Backup and Restore 

Server Image > Create Server Image. 

 

 

 

 

 

  3.  Enter the following information: 

– Name of Virtual Server Image: vm192168080129-Backup-1 

– Description of Virtual Server Image: [enter something meaningful] 

– Select Project Name: <your_initials>01 

– Select Server Name: vm192168080129 

 

  4.  Click OK to submit the request. 

The request in the My Requests portlet listed first as New, Queued, 

and then In Progress. Wait for the request to reach a Resolved 

status. 

 

  5.  When the request completes, click Manage Servers in the My Projects portlet. 
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  6.  Click the button next to vm192168080129 to view the details for that 

server. The name of the backup that you just made is listed under 
Saved Images for this Server. 

 

  7.  Close the Manage Servers window. 
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Fundamentals of Cloud Computing 

 

 

Exercise 14: Deleting a virtual server 
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In this exercise, you delete one server from your project. You cannot delete 

both servers because the predefined project landscape does not accept 

empty projects. In the next exercise, you deprovision the final server and 

cancel the project. 

  1.  If you are not already logged in, log in to the self-service UI as 
cloudadmin with password object00. Verify that you are 

working for the PMRDPCUST customer. 

 

  2.  Click Request a New Service > Virtual Server Management > Modify Project > 

Remove Server. 

 

 

 

  3.  Select <your_initials>01 from the Project Name drop-down list. 

 

  4.  Select the server with host name vm192168080129. 

The saved image for vm192168080129 is listed. 

 

  5.  To keep this saved image, scroll down and click the check box for 
Keep existing saved images of this server after it has been 

removed. 
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  6.  Click OK to submit the remove request. Click Yes at the Remove Server 

confirmation. You should see a Remove Server vm192168080129 

request in the My Requests portlet. Wait for the request to complete 

before continuing. This request might take 5 minutes or longer to 

complete, depending on system load. 
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Fundamentals of Cloud Computing 

 

 

 

Exercise 15: Canceling a project 
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In this exercise, you cancel an operational project. This action de-provisions all 

virtual machines that are associated with the project, assigning those resources 

(processor, memory, and disk) back into the cloud pool. The status of the project 

becomes Decommissioned so that it can be accounted for in reporting and 

usage accounting, if you enable those features. 

  1.  If you are not already logged in, log in to the self-service UI as 
cloudadmin with password object00. Verify that you are 

working for the PMRDPCUST customer. 

 

  2.  Click Request a New Service > Virtual Server Management > Cancel 

Project. 

 

 

 

  3.  Select <your_initials>01 from the Project Name drop-down list.Scroll 

down to view the check boxes for Save an image of each server 

when the project reaches its end date and is being 

decommissioned and Keep existing saved images after the project 

has been decommissioned. 

 

  4.  Select the check boxes for both options. 
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Note: The save statement means that a new backup of the server is taken 

before deprovisioning. The keep statement means that any existing backups 

will not be deleted. 

 

  5.  Click OK to submit the request. 

 

  6.  Click Yes at the Cancel Project confirmation. 
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  7.  When the request Cancel Project <your_initials>01 has a Resolved 

status, check to see that the backups are complete and the 

deprovisioning of the virtual machine resources has occurred. 

Open the VMware vSphere client. 

The two virtual machines, vm192168080129 and vm192168080130, 

have been deleted. Two saved images (clones) still exist: 

– One clone represents the backup image that you manually initiated (named 

similar to 

vm192168080129-Backup-1_nnnnn). 

– The other clone represents the backup image that Tivoli Service 

Automation Manager automatically took during the Cancel Project 

request (named similar to 
vm192168080130_autoSavedOnExit_nnnnn). 

 

 

 

 

  8.  Minimize the VMware vSphere client. 

The project <your_initials>01 has a Decommissioned status in the My 

Projects portlet. 
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Fundamentals of Cloud Computing 

 

 

 

Exercise 16: Creating a project with a virtual 

server restored from a saved backup image 
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In this exercise, you create a new project with a VMware virtual server. The virtual 

server is created from a saved backup image from your earlier project. It is 

possible to use the same name as a previous project, which you do in this 

exercise. 

  1. If you are not already logged in, log in to the Tivoli Service Automation 
Manager self- service UI as cloudadmin with password object00. 

Verify that you are working for the PMRDPCUST customer. 

 

  2.  Click Request a New Service > Virtual Server Management > Create 

Project from Saved Image. 
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  3.  Enter the following information: 

– Project Name: <your_initials>01 

– Team to Grant Access: TEAM0 

– Project Description: [Enter a meaningful description.] 

– Start Date: [Use the default value of today.] 

– Start Time: [Use the default value.] 

– End Date: [Use the default value of two weeks from today.] 

– End Time: [Use the default value.] 

– Resource Group Used to Reserve Resources: VMware System x 

– Select Image Name: [Select any backup image] 

– Save an image of each server when the project reaches its 
end date and is being decommissioned: [checked] 

– Keep existing saved images after the project has been decommissioned: 

[checked] 

 

 

 

Note: There are no options for resource requirements (processor, memory, 

and disk) or software to install, because the server that you are 

provisioning is an identical copy (clone) of the original virtual server that 

you backed up. 

 

  4.  Click OK to submit the request. 

The request in the My Requests portlet listed first as New, Queued, and then In 

Progress. 
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  5.  Verify that the status of the <your_initials>01 deployment request is 

Resolved in the My Requests portlet before continuing. 

 

 

  6.  Open the VMware vSphere client. Verify that the virtual server, 

vm192168080129, has been created from its saved image: 

 

 

 

 

  7.  Log out of the self-service UI. 
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Fundamentals of Cloud Computing 

 

 

Exercise 17: Requesting a new project with 

additional software as a different customer 
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With Tivoli Service Automation Manager, you can create customers to provide 

different functions to different groups of people or companies. In this exercise, 

you log on as a user from the TIVED1 customer. Notice that this user has 

access to different software packages and virtual machine templates. With 

Tivoli Service Automation Manager, you have granular control over these items 

and many more. 

It is possible to install software as part of the virtual machine deployment. You 

deploy a virtual machine with the HTTP server in this exercise as a single 

provisioning activity. To perform these tasks, you must log in with a user ID 

that has a role of either Cloud Administrator or Team Administrator. 

  1.  Log in to the self-service UI as tived1admin with password object00. 

  2.  Verify at the top of the self-service UI that you are now logged in as the 
administrator of team1 for customer TIVED1. 

 

  3.  Click Request a New Service > Virtual Server Management > Create Project with 

VMware Servers. 

  4.  Enter the following information on the Project Details window: 

– Project Name: <your_initials>03 

– Team to Grant Access: TEAM1 

– Start Date: [Use the default value] 

– End Date: [Use the default value] 
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Notice that a different team (TEAM1) is available for this customer. 

 

 

 

 

  5.  Click Next. 

 

  6.  Enter the following information on the Requested Image window: 

– Resource Group Used to Reserve Resources: VMware System x 

– Image to be Deployed: SLES_image2 (Notice that a different image 

(SLES_image2) is available for this customer) 

– Number of Servers to be Provisioned: 1 

 

 

 

  7.  Click Next. 
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  8.  Enter the following information on the Server Details window: 

– Virtual CPU: 1 

– Physical CPU: 0.3 

– Main Memory: 1.0 GB 

– Swap: 0 GB 

– Disk: 3 GB 

 

  9.  Click Next. 

 

  10. On the Additional Software window, select the IBM Http-Server 

software and use the right arrow to move it from Available Software 

to Selected Software. 

The HTTP software was available to the TIVED1 customer, but not the 

default customer used by cloudadmin. 
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  11. Click Finish to accept the defaults for the remaining options. 

 

  12. Review the summary page, and click Finish to submit the request. 

The request in the My Requests portlet listed as New, Queued, or In 

Progress. 

  13. Continue to the next lab exercise when your request is In Progress. 

Notice that the My Requests portlet does not contain any information 

about the activities of the other customer. 

 

 

 

User tived1admin receives an email that the request has been accepted. 
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Fundamentals of Cloud Computing 

 

 

Exercise 18: Monitoring the deployment 

status (optional) 
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In this exercise, you monitor the deployment of the new virtual server deployed 

with the HTTP server in the previous exercise. 

  1.  Log in to the Tivoli Service Automation Manager administrative UI as 

maxadmin with password object00. 

 

  2.  Click Start Center > Provisioning 

Workflow Status. You see two 

workflows in progress for your 

request. 

 

 

  3.  Click the number in the Deployment Request column that coincides 
with RP.ClusterProvision. You see the execution details of the 

virtual machine deployment workflow. 

 

  4.  Click the Refresh icon to update the page. Continue to the next step 

while the workflows are in progress. 

 

  5.  Log in to the VMware vSphere Client as Administrator with password 

object00. You see the virtual machine being cloned. Use the Recent 

Tasks pane to monitor the progress. 

 

 

 

 

 

Cloning the virtual machine is the first of several tasks performed at the 

VMware vSphere Client. When the cloning completes, monitor the 
status to see a new virtual server with the vm19216880131 name is 

created. 
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  6.  Return to the Tivoli Provisioning Manager Provisioning Workflow Status 

page to view the progress of the workflows. Wait for the workflows to 

finish. This task might take up to  15 minutes to complete. You can 

explore other areas of the product while you wait. The workflows status 

shows a Success status after the workflows are completed. Notice that 

a third workflow started to install the HTTP server. 

 

 

 

Tip: The execution log for the SoftwareModule.Install workflow contains 

approximately 160 records when the software installation completes. The 
execution log for the RP.ClusterProvision workflow contains approximately 

765 records when the provisioning completes. Tivoli Service Automation 

Manager deploys the virtual machine and then installs your requested 

software. 

 

 

  7.  Return to the self-service UI. 

  8.  Verify that the status of the Create project <your_initials>03 request is 

Resolved in the 

My Requests portlet. 

  9.  Open the Mozilla Thunderbird application. Select the tived1admin user. 

  10. Open the email with a subject Your request to start a new project has 
been processed. The text describes the virtual server, similar to the 

following example: 
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Dear TIVED1 TEAM1 Admin, 

you have started a new project Demo03 with the following topology: 

The server vm192168080131 has been added with the following 

parameters: 

Server host name: 

vm192168080131 Number of 

CPU(s): 1 

Number of tenths of physical 

CPUs: 3 Amount of Memory: 

1024 MB 

Swap Size: 0 GB 

IPv4 address(es): 

192.168.80.131 IPv6 

address(es): 

Disk Space Size: 

3 GB Admin 

Password: 

<password> 

 

  11. Write the Admin password here: _. 

The HTTP server is installed, but not started as part of the deployment. 

You must manually start it. You can use either the VMware vSphere 

Client or PuTTY to access the virtual server. 
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  12. To use PuTTY to start the HTTP server, perform the following steps: 

  a.  Start an instance of PuTTY from the desktop of vm104. 

 

  b.  Specify an IP address of 192.168.80.131. 

  c.   If prompted with a security alert, click Yes. 

 

  d.  Log in as user root with the Admin password that you wrote down. 

 

  e.  Issue the following command to start the HTTP Server: 

/opt/IBMIHS/bin/apachectl start 

You will not see any messages if the start is successful. 

 

  f.   Type exit to close the PuTTY session. 

 

  g.  Verify that the HTTP server was installed correctly. Use Mozilla 

Firefox to connect to the IBM Http-Server running on 

vm192168080131 using this web address: 

http://192.168.80.131/ 

You see the following screen. 

 

 

 

 

 

The IBM HTTP Server screen indicates that you have successfully 

installed the additional software on vm192168080131. 

http://192.168.80.131/


FCC - Exercises – Guide for Students  Exercise 19 

© 2014 IBM Corporation Page 84 of 173 



FCC - Exercises – Guide for Students  Exercise 19 

© 2014 IBM Corporation Page 85 of 173 

 

 

 

 

 

 

Fundamentals of Cloud Computing 

 

 

Exercise 19: Disabling automatic approval 
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In this exercise, you disable automatic approval, which results in all service 

requests requiring cloud administrative approval in the self-service interface. 

  1.  If you are not already logged in, log in to the Tivoli Service 
Automation Manager administrative UI as maxadmin with 

password object00. 

  2.  Click Go To > System Configuration > Platform Configuration > System 

Properties. 

  3.  If the row filter is not visible, click Filter. 

  4.  Using the row filter, search for and select the property 

PMRDP.ENABLE.AUTOAPPROVAL. 

  5.  Click View Details to edit the property value. 

  6.  Change the Global Value to N. 

 

  7.  Click Save Property. 

  8.  Select the check box to the left of the PMRDP.ENABLE.AUTOAPPROVAL row. 
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  9.  Click the Live Refresh icon (or select it from the Select Action 

menu) to update the current value of the property. 

 

 

 

 

 

Click OK in the pop-up window to run the live refresh. 
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Fundamentals of Cloud Computing 

 

 

Exercise 20: Submitting a service request to 

restart a virtual machine 
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In this exercise, you submit a service request to restart a virtual server that is part of 

your project. 

  1.  If you are not already logged in, log in to the self-service UI as 

tived1admin with password object00. 

 

  2.  Click Request a New Service > Virtual Server Management > Modify Server > 

Restart Server. 

 

 

 

 

 

  3.  Enter the following information: 

– Project Name: <your_initials>03 

– Server: vm192168080131 

 

  4.  Click OK to submit the request. 

 

  5.  In the My Requests portlet, verify the status the service request. When the 

status indicates 

Waiting on Approval, move to the next step. 
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  6.  Log out of the self-service UI. 

 

  7.  Log in to the self-service UI as cloudadmin with password object00. 

Verify that you are working for the TIVED1 customer. 
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  8.  Scroll down until you see the My Approvals portlet. You should see 

the new request is waiting for your approval. 

 

 

 

 

 

  9.  Click the request that is waiting for approval. 

 

  10. Select Approve request and enter Server restart approved in the Details field. 

Click 

OK. 

 

 

 

  11. Monitor the status of the service request in the My Requests portlet. 

When it indicates a status of Resolved, the server restart has been 

completed. If you want, you can proceed to the next exercise while the 

request completes. 
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Fundamentals of Cloud Computing 

 

 

Exercise 21: Viewing Tivoli Service 

Automation Manager reports 
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In this exercise, you view Tivoli Service Automation Manager report data 

collected for your project, <your_initials>01. 

 

Note: In the self-service UI, <your_initials>01 is referred to as a project, and 

as a service deployment instance in the administrative UI. 

  1.  Log in to the Tivoli Service Automation Manager administrative UI as 

maxadmin with password object00. 

  2.  Click Go To > Service Automation > Service Deployment Instances to open 

the 

Service Deployment Instances application. 

  3.  Tab to the Service Deployment Instance filter field and press Enter to 

display all service deployment instances (projects). 

  4.  Click a project whose status is Operational, such as 

<your_initials>03, for the PMRDPCUST customer. 

  5.  Click the Service Topology tab. Verify that your topology nodes 

look similar to the following example. 

 

 

Your project, <your_initials>03, is listed with a server and virtual server 

instance. The virtual server instance is linked to a software stack per 

virtual machine (vm192168080129, for example). 
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  6.  Select Run Reports form the Select Action menu. 

 

  7.  When the Reports window opens, click the RDP History Detail report. 

  8.  When the Request Page pop-up window opens, type the name of your project, 

<your_initials>03, in the Servicename field and click Submit. 

Another Internet Explorer window opens for the BIRT Report Viewer 
with the Service Instance RDP Detail Usage History report. 

 

The Service Instance RDP Detail Usage History report graphs host, 

processor, and memory over time for the project. These graphs display 

each item across all supported hypervisors. This data is also available 

to IBM SmartCloud Cost Management (SCCM) after you configure the 

Tivoli Service Automation Manager integration with SCCM. 

  9.  Scroll down to view the report data for processor and memory. 

You have now completed the Cloud Proof of Technology lab exercises for IBM 

Tivoli Service Automation Manager. If you have additional questions, contact 

your facilitator. 
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Fundamentals of Cloud Computing 

 

 

Exercise 22: Logging into the standalone 

VMware ESX server 
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In this exercise you'll log into the system and then use vSphere Client to connect 

to the VMware ESX Server. 

 

1. Log into the system using username Administrator and password object00 

 

2. Run VMware vSphere Client that is present on the desktop. 

3. When the window opens, uncheck Use Windows session 

credentials and provide: 

a) IP address: 192.168.80.105 

b) username: root 

c) password: object00 
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4. In the top bar click Home, you should see limited number of 

options present when connecting to the standalone ESX server: 

5.  
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Fundamentals of Cloud Computing 

 

 

Exercise 23: Exploring general hypervisor 

information 
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In this exercise you'll explore several tabs with the information about the host status. 

 

1. Starting from the Home screen in the previous exercise, click Inventory. Once you 

see the inventory screen, click + sign near host (192.168.80.105) in the root of the object tree 

on the left side: 

2. Make sure the root of the object tree is selected. You should see the screen similar to 

the one shown. 

3. The Getting Started page is the main page with basic introductory information and 

common tasks. Click Summary tab. 
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4. The Summary tab shows general information about the hypervisor capacity and 

current resources consumption. 

a) In the General panel there are information about licenses, CPU capacity, number of 

VMs and templates and etc. Notice different information about CPU present. 

 Processor Sockets number is number of physical multicore processors available. 

 Cores per Socket is the number of the cores (physical) present in each processor. 

 Each processor can process instructions using multithreading technology (Intel name: 

Hyperthreading). It results in having 2 simultaneously executed instructions per core. 

 This multiplied by total number of physical cores gives the number of Logical 

processors. 

b) In Commands panel administrator can run common actions on the Hypervisor, like 

rebooting or shutting it down or creating a virtual machine. 

c) Resources panel is the quick way for the administrator to check the resource 

consumption on the hypervisor. 

 The total number of MHz is the sum of all MHz for each physical core. Current total 

MHz consumption shown is proportional to the percent of total CPU utilization on the host. 

 Memory usage includes also some part of the memory used by the hypervisor. 

 Notice, that there is some utilization even though no virtual machines are 

running. 

 Below there is also a quick view on the list of defined datastores and networks. 
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5. Click on the Virtual Machines tab. This tab is an easy way to see the current 

resource utilization on the running virtual machines and also it is possible to perform 

standard actions like suspend or shutdown guest OS on multiple virtual machines (using 

Shift or CTRL keys). 

 

6. Click on the Resource Allocation tab. This tab enables you to assign reservations, 

and priorities to the virtual machines. 

a) For CPU and Memory you can set a reserved pool of resources assigned to the VM. 

 This means that selected VMs will have guaranteed resources, when they will need 

them. 

 Notice that Available Capacity is smaller then the total amount of memory available 

on the hypervisor. This is the result of reserving some resources for hypervisor itself. 

b) Shares Value is the numeric way of assigning weights to the resources for each VM. 

 This enables administrator to give for a particular VM i.e. twice as much CPU cycles 

or twice as high priority when accessing memory then the other VM. 

 % Shares column shows resulting percentage of the shares assigned to each VM. 

 Example: if one VM has shares value for CPU equal to 3000 and the other 1000, then 

former will have 75% of the CPU time, and the other only 25%. 
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performance 
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In this exercise you'll explore the performance information available for the hypervisor. 

 

1. Click on the Performance tab. 

 

2. By default CPU perspective should be opened. 

a) This gives the administrator resource utilization information for last 1 hour. 

b) For CPU the history of utilization is shown for each core, however, more valuable can 

be vm105.tivoli.edu CPU Usage data series, which gives the average utilization for all cores 

resulting in a more general view of what is the host CPU utilization. 
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3. Switch to the Disk perspective. 

a) This perspective gives the information about current disk activity. 

b) The information presented covers all of the controllers available and the average for 

hypervisor. Reads and writes are separated. 

4. There is also a very useful measurement for the storage subsystem performance – 

read/write latency. Click Chart Options, a window should be opened: 
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5. On the left Disk → Real-time should be selected. 

6. In the Counters list, select Disk Read Latency and Disk Write Latency. Click OK 

button to close window. 

7. New series will be added to the chart. 

a) Disk latency is a good performance measurement. The higher the value, the slower 

the response of the virtual systems is. Up to 10 ms is a reasonable response time. 

b) Notice that virtualization generally assumes that the workload will be spread across 

different virtual machines in time. Therefore, if several workloads will need to access storage 

more often at the same time, the response time can quickly grow to high values and seconds 

later go back to 0. 

c) The Average column is a good indicator of an overall storage performance, cause it 

takes into consideration data collected for a longer period of time. 

8. Switch to the Memory perspective. This perspective shows details about memory 

consumption for each type of memory allocation. 
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9. Currently, no virtual machines are running, however, you should know the meaning of 

each measurement: 

a) Granted – memory granted to the virtual systems – it grows gradually, even though 

guests systems see all of the memory assigned to them. Moreover, this value can be greater 

then the physical memory available on the hypervisor. 

b) Active – memory that is used currently by the virtual systems 

c) Consumed – physical memory consumption, this value at maximum is close to the 

total physical memory available. 

d) Balloon – memory used by Ballooning technique for collecting unused memory from 

the systems that don't need it at the moment and given to the systems that need it. 

e) Shared common – memory shared between virtual systems (Transparent Page 

Sharing mechanism). 

 If you have many similar environments, they may keep in the memory the same 

memory pages – to save memory, hypervisor shares memory pages, that are the same 

across multiple environments. 

 If the page is modified, the hypervisor will then allocate a new page (Copy-On-Write 

mechanism). 

f) Swap used – memory swapped to the hard disk, however notice that this is the 

memory swapped by the hypervisor not the guest OS when other mechanisms fail 

(ballooning and TPS) 
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Exercise 25: Managing datastores 
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Hypervisor needs a storage for virtual machines. In this exercise you'll remove datastore and 

add it again to see how storage is visible and can be managed by Hypervisor. 

 

1. Click on the Configuration tab on the hypervisor level. 

2. Click on the Storage link in the Hardware panel. 

 

3. A list of configured datastores is shown. Click on any datastore on the list to 

see 

details. 
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4. Notice the following information: 

a) Capacity – free and used space is shown. Used space value takes into consideration 

the fact that some of the virtual machine disks are thin provisioned. 

b) Paths – is the number of connections to the underlying storage. In SAN, you can 

have multiple links between server and storage subsystem. This is used for both 

performance and high availability purposes. 

c) Extents – datastores can consist of multiple extents, so you can create several LUNs 

on your disk array, and merge them to act as a single datastore on the hypervisor. 

5. Select vm105:storage2 (Important: select the storage that doesn't have any data on 

it – look for usage information shown below, and verify it with right click and Browse 

datastore). 

6. Click Delete link. 

7. Confirm with Yes button. 

8. The datastore should be removed from the list after couple of seconds. You can click 

Refresh if it doesn't refresh automatically. 

 

9. This is a moment, when you have configured your storage, created a new LUN and 

now you want to add it to the hypervisor. Click Add Storage. 

10. Select Disk/LUN as Storage Type and click Next. 
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11. At this moment hypervisor searches for LUNs and disks available. There is a directly 

connected disk to the hypervisor that was previously used by vm105:storage2 datastore 

which now is available. Select the disk that has been found and click Next. 
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12. Review current layout and click Next. 
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13. In the next screen, provide a name Storage2 and click Next. 
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14. In Formatting section choose 1MB as a block size. 

a) Note the limit for the file size that is different for each block size (the larger the block 

size, the larger the limit). 

b) This limit is important, if you need to store large virtual machine disks. 
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c) Click Next 

 

15. In the final screen review the summary and click Finish 

16. After a few seconds your datastore should appear on the list. 
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17. In the future, the datastore can be extended by adding another LUN to it. 

a) It can be done by clicking Preferences for selected datastore and using Increase 

button. 

b) Click Close button. 
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Exercise 26: Exploring Virtual Machine files 



5FCC - Exercises – Guide for Students  Exercise 26 

© 2014 IBM Corporation Page 122 of 173 

 

In this exercise you'll explore files necessary for virtual machine to run. 

 

1. Starting from the Storage section in Configuration tab right-click on 

vm105:storage1 and select Browse datastore. 

 

2. Click on the myvm01 folder on the navigation tree to see the contents. 

 

3. Virtual machine consists of set of files: 

a) .vmdk files are the virtual machine disks, where the actual data is being stored. There 

are three main formats of the virtual machine disk files: 

 thick provisioned – the hypervisor allocates a file of the size of the requested disk 

— so even if there is no data inside and a 100 GB disk has been created, then the 

corresponding file will occupy 100 GB of the storage space. 

— Important: it is sometimes important to guarantee the storage that has been assigned 

to the VM, so this type is commonly used in IaaS environments. If the storage is filled up, and 

some VMs using thin provisioned disks wouldn't have space to store their data, they would 

be suspended, even though inside the virtual machine the OS sees free space. 



5FCC - Exercises – Guide for Students  Exercise 26 

© 2014 IBM Corporation Page 123 of 173 

 thin provisioned – the hypervisor also allocates a file of the size of the requested disk, 

but this time, there is an information in the file system that this particular file occupies only 

the space needed to store it's contents 

— as a result if the VM requires only 10 GB of space to store it's data inside 100 GB 

disk, then hypervisor will mark only 10 GB as used. 

— useful for test and dev environments, when you don't need to guarantee the storage 

provisioned, and you need to consolidate as much virtual environments as you can 

— Important: information about thin provisioned disk is stored in file system only, 

therefore if you copy or download VMDK file, it will result in full 100GB file that you need to 

store on your target storage. Use vmkfstools command or Move option of the VM in the 

vSphere Client connected to the vCenter Server. 

 2GB sparse – this format is used mainly for moving or storing VM disks. It splits vmdk 

files into chunks smaller then 2GB each. 

— It means that 32GB vmdk file will be splited into 16 chunks, each smaller then 2GB to 

be able to put this file on other filesystems with 2GB file size limit, like FAT32. 

— All of the files contain only data blocks, which means that using 10GB of data out of 

100 GB volume, we should expect around 10GB of total space needed. 

— VMDK parts can be copied or downloaded directly and their size will remain the same 

b) .nvram – stores BIOS settings of the Virtual Machine 

c) .vmx – main configuration file of the Virtual Machine 

 human-readible file with set of property-value pairs keeping the most important 

parameters of the virtual machine like memory, CPU resources or virtual disk attached 

 with right-click Add to inventory option can be used to register VM 

d) .vmxf – extended file with additional configuration parameters 

e) .vmxt – the same as .vmx but used by virtual machine templates instead of virtual 

machines 

f) .log – log files with actions performed on VM 

g) .vmsd – file storing information about snapshots done on the VM. 

4. Explore icons on the top of the browser. Using them you can upload/download files 

and directories, create directories, delete files and directories or move them across 

datastores. 

5. Close the browser window. 
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Exercise 27: Networking 
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In this exercise you'll see the networking configuration on the hypervisor and add a new port 

group to your hypervisor, which later can be used by your virtual machines. 

 

1. Starting from Configuration tab at hypervisor level click Networking link. Current 

networking configuration should be displayed 

 

2. Each vSwitch (virtual switch, responsible for packet switching similar to the physical 

switch) can be assigned a set of physical network adapters. 

a) Network adapter can belong to one vSwitch only. 

b) Virtual machines have virtual network interfaces which are assigned to the specific 

Port Group, which is a way of dividing networks on the hypervisor level. 

c) Each Port Group can be assigned to the specific VLAN, to isolate virtual systems 

between them. 
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3. To create a new port group click Add Networking link. A window opens. 

4. Choose Virtual Machine in the Connection Types section and click Next. 



5FCC - Exercises – Guide for Students  Exercise 27 

© 2014 IBM Corporation Page 128 of 173 

 

5. Select Use vSwitch0. Look how the the topology preview has changed and click 

Next. 

6. In the Connection Settings section provide: 

a) a Network Label for you network, i.e. My Network 

b) VLAN ID, i.e. 123 

7. Click Next. 
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8. In the final screen confirm by clicking Finish button. 
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9. Verify that your new network is present. 
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Exercise 28: Creating a new Virtual Machine 
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In this exercise you'll create a new clean Virtual Machine ready for your operating system to 

be installed. 

 

1. Right-click on the hypervisor object in the object tree on the left and choose New 

Virtual Machine option from the menu. 

 

2. In the first screen choose Custom and click Next 

 

3. In the Name and Location provide a name for your VM, i.e. My VM and click Next. 
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4. Select Storage2 as a the datastore in which VM will be stored and click Next. 

 



5FCC - Exercises – Guide for Students  Exercise 28 

© 2014 IBM Corporation Page 134 of 173 

5. In the Virtual Machine Version section leave version 7 setting of the configuration 

and click Next. 

 

6. In the next section, select operating system type and version, that is going to be 

installed in your virtual machine, i.e. Linux and Red Hat Enterprise Linux 6 (64-bit) and 

click Next. 

a) This information is used in next sections to suggest best settings for this particular 

operating system. 

b) It is also used for choosing necessary VMware Tools packages to be installed 

(different for every OS). 



5FCC - Exercises – Guide for Students  Exercise 28 

© 2014 IBM Corporation Page 135 of 173 

 

7. In the next section set Number of virtual processors to 1 and click Next. 
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8. In the Memory section, leave the defaults (1 GB) and click Next. 
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9. In the next section you can define network adapters and attach them to port groups 

defined on your hypervisor. 

a) Use a single NIC connected to the VM Network and using VMXNET 3. 

b) Make sure Connect at Power On checkbox is checked. 

c) Click Next 

 

10. In the SCSI Controller section you can select virtual disk controller type used in your 

VM. Depending on the OS, different controller may have to be used. 

a) Use default for your OS, in this case VMware Paravirtual has been selected by 

default by the wizard. 

b) Click Next button 
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11. In the Select a Disk section you can either select an existing virtual disk or create a 

new one. 

12. Choose Create a new virtual disk and click Next. 
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13. A new section has appeared, where you can provide details about disk being created. 

14. Set the following: 

a) Disk size: 8 GB 

b) Check the Allocate and commit space on demand (Thin Provisioning) option, to 

use Thin Provisioning for the new disk 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

15. Click Next to proceed to the Advanced Options section. 
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16. Notice the Independent option for a virtual disk. 

a) This option implies that the virtual disk will not be affected by the snapshot 

mechanism 

b) There are 2 types of this option: 

 Persistent – all of the data will be directly saved to the specified virtual disk, 

snapshots will not affect it 

 Nonpersistent – like the option above, but changes made to this disk will be lost when 

the VM is being restarted 

17. Click Next. 

18. Review the summary and click Finish button. 

 

19. Your VM has been created and is ready for the OS to be installed. It should appear in 

the object tree on the left. 
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20. Click My VM in the object tree and select Summary tab to verify your settings. 
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Exercise 29: Modifying Virtual Machine settings 
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In this exercise you'll modify Virtual Machine settings. 

 

1. Right-click on the My VM and choose Edit Settings 

 

2. Settings window appears. Change amount of RAM to 512 MB. 

 

3. Click CPUs and change the number of virtual processors to 2. 
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4. Select Network adapter 1 and change Network label to My Network (network that 

has been defined in previous exercises). 

 

5. When you select CD/DVD Drive 1 you can also select source of your OS installation. 

a) It can be a client device (on your local client machine), a host device (on the 

hypervisor  server) or an ISO in specific location in your datastore. 
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6. Now add a new virtual disk to the virtual machine. Click Add button. 

 

7. Choose Hard Disk and click Next. 

8. Select Create a new disk option. 
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9. Select disk size to be 8 GB and check the Thin Provisioning option. 

 

10. In the Advanced Options section leave defaults and click Next. 
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11. Review the summary and click Finish button. 

 

12. Review changes that you had done to the virtual machine configuration and click OK 

button. 
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13. In the Summary page you should see new settings. 

14. Right-click on the Storage2 in the Resources panel and click Browse datastore 
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15. Click on the VM directory on the left to see the files. 

16. Datastore Browser opens. Notice that: 

a) there is no log files or nvram files before first run 

b) both virtual disks are thin-provisioned and their size is 0 (although both are 8GB from 

the guest OS perspective). 
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Exercise 30: Using Virtual Machine console 
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In this exercise you'll power on a VM and connect to it's display using Console tab. 

 

1. Select myvm01 from the object tree on the left and click Power On (green triangle) 

button. 

 

2. Click on the Console tab. A question window is shown. 

 

3. Choose I copied it option and click OK button. 

4. Notice the state of the VM changed to running. 

 

5. Use right scrollbar to scroll console contents down. When OS finishes booting the 

login prompt appears. Click inside the Console to control keyboard inside VM. 

6. Log in as root with password object00. 

7. Run ls command to list directories inside VM. 



5FCC - Exercises – Guide for Students  Exercise 30 

© 2014 IBM Corporation Page 155 of 173 

 

8. Use Ctrl+Alt keys to leave console. 
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Exercise 31: Creating user role on the 

Hypervisor 
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In this exercise you'll create an operator role with set of privileges assigned to it. 

 

1. Click Home in the navigation bar and select Roles 

 

2. The list of currently defined roles shows. 

 

3. Click Add Role button. 

4. An Add New Role window appears. Provide: 

a) role name: Operator 

b) privileges: select all in Virtual Machine subtree 

5. Click OK button. 
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6. New role appears on the list. 

 

7. Click Home in the navigation bar. 

8. Click Inventory and on the hypervisor level select Users & Groups tab. 

9. Right-click anywhere on the list of users and select Add. 
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10. In the window opened provide: 

a) user login: moderator 

b) password: object00 

 

11. Click OK button. 

12. New user account is shown in the list. 



5FCC - Exercises – Guide for Students  Exercise 31 

© 2014 IBM Corporation Page 161 of 173 

 

13. Click on My VM in the object tree on the left and select Permissions tab. 

14. Right-click anywhere on the list and select Add Permission. 

 

15. New window opens. Click Add button. 
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16. In the next window find moderator user in the list and click Add button. 

 

17. Click OK button to close the window. 
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18. Click OK button to close the window and add privilege to the user. 

19. New privilege appears in the list. 

 

20. Use desktop icon to start new vSphere Client. Log in to the same hypervisor as 

moderator with password object00. 
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21. Notice that moderator doesn't have any privileges at the hypervisor level. And is able 

to see only My VM. 

 

22. Click My VM in the object tree. 
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23. Notice that moderator user has full control over the My VM. 
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Exercise 32: Exploring vCenter Server features 
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In this exercise you'll connect to the vCenter Server and explore the interface of the vSphere 

Client. 

 

1. Click Start Menu button and select Run. 

2. Type services.msc 

 

3. Verify that VMware VirtualCenter Server service is Started. If not use Start link to 

start the vCenter Server. 

 

4. Close Services window. 

5. Use vSphere Client shortcut on the desktop to start vSphere Client. 

6. Use localhost in the IP address / Name field and check the Use Windows session 

credentials checkbox. 
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7. Click Login button. 

When the window opens, click Home in the navigation bar. 

 

8. Notice new options shown when connecting to the vCenter Server instead of ESX 

server. 

9. Click VMs and Templates 

10. The root in the object tree is now vCenter Server. 

a) Below, there is a datacenter object, used to group multiple objects in your datacenter. 

b) vCenter Server discovered VMs running on the ESX node 
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11. Click Inventory → Hosts and Clusters in the navigation bar. 

 

12. Notice that under tsamdc datacenter object there is a CloudCluster object. Inside 

this cluster there is vm105 ESX node and all VMs registered on it. This is a typical hierarchy. 

Administrator can managed hypervisors via single console. 

13. Explore tabs present in this view. 

14. Click on the CloudCluster. 
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15. Notice three abbreviations in General panel: 

a) DRS – is a Distributed Resource Scheduler used to relocate VMs between 

hypervisors according to the workload (this is used to balance workload in virtualized 

environments). 

b) HA – High Availability – this is used to automatically restart VMs from failed 

hypervisor on the other in the cluster 

c) EVC – is the option to use standarized CPU features across hypervisors to be able to 

move running VMs even if the hypervisors have different CPU models. 

16. Right-click on the CloudCluster and select Edit Settings. 
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17. This window enables you to turn on DRS and HA features. 

 

18. You can also customize DRS settings to act more or less automatically. 
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19. Explore other settings available now in vSphere Client. 

20. After you're done close vSphere Client and log out from Windows. 

 


